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Introduction 
This guide introduces you to the fundamental navigation of CCH Axcess Tax that assists you in effectively learning 
and using the program. 
 
We will emphasize the key areas of navigation and how that can help you prepare and review returns using CCH 
Axcess Tax. In addition, we will introduce you to a wide variety of techniques for getting help with questions, 
including help screens, cross-references and more. 

Continuing Professional Education 
This course qualifies for two hours of Taxes CPE credit.  
 
Visit EngageTax.WoltersKluwer.com/training/feedback to request CPE and provide an evaluation of this course. 

Session code:   Account number:   

**CPE Qualification may vary by state** 

Objectives 
Upon completion of this course, you should be able to:  

• Use Return Manager to quickly access existing tax returns or create a new return 

• Use the ribbon for program navigation and customize the quick access toolbar 

• Set user options 

• Navigate and enter data in Worksheet View 

• Import and export data to and from the Worksheet summary grids using a spreadsheet 

• Utilize the various on-screen review techniques 

• Identify and utilize the extensive online help tools 
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Keys Quick reference to the key aspects of a function 

 
Tip Best practice tips and shortcuts 

 
Notes Informational notes about functions 

 
Write Steps or information to write down 

 
Caution Important warnings about a function 

 
Movie Video clips with additional training tips 

  

http://engagetax.wolterskluwer.com/training/feedback
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Getting Started in CCH Axcess Tax  
This section covers the general navigation features and the user options available to create and process tax 
returns of all types. CCH Axcess Tax allows you to process federal and state tax returns for Individual, 
Partnership, Corporation, S-Corporation, Fiduciary, Exempt Organization, Employee Benefit Plans, and Estate and 
Gift Tax returns. Refer to the Individual, Partnership, and Corporation training guides for detailed return-type 
information. 
 
In the CCH Axcess Suite, you can open or create returns using the Dashboard or CCH Axcess Tax icon from the 
desktop folder. Use the Install and Update Manager to check for program updates or to schedule the updates to 
install automatically. 
 
 
 
 
 
 
 

Login and Password 
Each staff member logs in with a unique User ID and password that the administrative staff configures. The 
administrator also assigns a variety of functional rights to each staff member. 
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User Options 
Tax User Options are accessible from the Dashboard or the Application button in Return Manager. User Options 
enable features in CCH Axcess Tax and set defaults for other Tax functions. You can also change your password 
and security questions and answers here.  
 

 
 For a complete overview of your User Options click Setting Your Tax User Options 
 

.  
  

https://z001download.cchaxcess.com/PfxBrowserHelp/TAXHelp/Content/Resources/Snippets/Common/UserOptions/UO_Tax_Overview.htm?tocpath=Getting%20Started%7CDefault%20Settings%7CUser%20Options%7C_____0
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Return Manager 
Return Manager is a powerful tool that lets you manage your returns with ease. You can open Return Manager 
from the Application Links page of the Dashboard. You can also go straight to Return Manager by Clicking the Tax 
icon in the CCH Axcess folder. 
 

 
 
Return Manager tools include: 

• Open tax returns for multiple years   
• Create tax returns and templates 
• Roll Forward returns 
• Set to Prohibit Changes 
• Data grid customization 
• Quick look at Federal, State and City e-file status 
• Set user options using the Application Button 

 

Create and Open Tax Returns and Tax Return Templates    
Create or open tax returns and templates using the File menu in Return Manager.  

Creating New Returns  

Provided you have the functional rights, you can create new clients when adding new returns. When adding 
returns for an existing client, the list of available clients is defined by your rights to access specific clients. You 
also have the option of entering a password to secure returns.  
 
The availability of return types depends on the client type established in the client profile and the return types 
licensed by your firm. 

 
Click Here for Adding and Securing Tax Returns 
 

https://z001download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Tax%20Returns/TR_Creating%20Tax%20Returns.htm?Highlight=create%20a%20new%20return
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Creating New Return Templates 

Tax templates allow you to set a master return for a tax year and return type, A tax template contains recurring 
information that you would like applied to new and rolled forward returns. You can create multiple tax templates 
for a return type and tax year, and they can be rolled forward each year.  

 
Click here for more information on Tax Templates  
 

Opening Tax Returns and Tax Return Templates 

Open an existing return or template by double-clicking the return in the Return List grid; or by highlighting the 
return and selecting Open on the Toolbar.  

 
The Return list grid is populated by returns defined by the Return Manager returns list option you set in User 
Options or returns defined by searches you perform.  
 
Three methods are available for searching for returns: 

• Client ID or Name 
• Quick Search 
• Search by View 

 

Client Search 

From the Toolbar, enter a Client ID or a 
client name in the search field and click the 
magnifying glass to perform a multi-year 
search of your firm’s database of tax 
returns. The results of the search are 
displayed in the Return List grid.  
 

Click the filter icon available in the column header 
to filter the results. The filter you select remains in place 
until you change it.  

 

Quick Search  

To further refine your search results, open the Quick Search 
pane. From here, you can customize the filters that are most 
relevant to you.  
 
The Quick Search panel offers greater flexibility as well as new 
options for filtering such as filters for in-use returns, last 
modified date, spouse name and more.  
 
Quick Search criteria searches the entire system, not just the 
current grid page contents. Results can then be saved as a new 
view.  
 
You can customize the filters that display on the Quick Search panel by adding or removing both default and 
optional filters. Client ID/Name is the only filter that cannot be removed. Your selected filters are saved for 
future searches.  

 
Click for more information on Default and Optional Filters  

https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Tax%20Returns/TR_Creating%20Templates.htm?tocpath=Return%20Manager%7CAdd%252FOpen%20Returns%20and%20Templates%7C_____2
https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Tax%20Returns%20Manager/TM_Quick%20Search.htm
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Using Views in Return Manager 

Views define the filters, columns, and 
sorting information to determine the 
records and associated data shown in the 
Returns grid. The default view is Recently 
Used Returns, for new users this will not 
show any returns until the returns have 
been opened.  
 
Return Manager includes the following 
system-defined views:  
 

• Recently Used Returns 

• Recycle Bin  

 
You can access pre-defined and custom 
views for both returns and templates from 
the Views drop-down or by selecting View > 
Change Current View from the drop-down 
menu at the top of the Return Manager 
window. Switch between Returns and 
Templates views via the tabs in the views 
drop-down. 
 
 
 

 
Click for more information on creating Custom Views  
 
 
Setting Your Return Manager User Options (cchaxcess.com) 
 

Working with the Return Manager Grid 
The grid lists returns, or tax return templates and displays all existing items for the selected view, client Search 
results, or Quick Search results. When the number of records exceeds a single page, you can move between 
pages of records using controls located below the grid. The number of records that are displayed in the Most 
Recently Used View is configurable using your User Options located at Application Button > User Options > 
Return Manager.  
 

Customizing Columns 

You can customize your columns and their sequence by using the Edit Columns option. To save your changes to 
your current view, click on Update View. The program default displays the most recently used returns and 
templates, but you can change the default to display the last view used using your User Options.  
 
You can also refine your search results by selecting the filter icon next to any column heading. 
 

https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Resources/Snippets/Common/Managing_Views/MV_ManagingViews.htm?tocpath=Return%20Manager%7CAbout%20Views%7C_____1
https://z001download.cchaxcess.com/PfxBrowserHelp/TAXHelp/Content/Resources/Snippets/Common/UserOptions/UO_Tax_TaxManager.htm
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Click any of the column headings to sort the grid by that item. The arrow in the column header indicates 
whether the sorting is in ascending or descending order. 
 

 

Client Details 

For 1040 returns created for tax years 2021 and later, you can 
quickly view client contact information by clicking on the 
information icon next to the taxpayer's name. This option will not 
be available on password-protected returns.  
 
  



CCH Axcess™ Tax Preparer  

Return Manager Page 7 

Updating Return Information from the Return Manager Grid 

From the Return Manager grid, users with functional rights may change the Return Configuration Set (RCS), 
Return Signer, and Return Description. You cannot change returns that are in use.  
 

 
To update the RCS or the return’s Signer, click the down arrow in the applicable column. You can enter a value or 
select from the available list options. For returns that are locked by Prohibit Changes, you can only change the 
Return Configuration Set.  
 
To add or change a return description, double-click in the Description column. Once you have completed your 
desired text, press enter. This description will also be visible throughout various Batch Manager functions.  
 

Exporting Grid Data 

You can export Grids to XLS or XLSX file types, by selecting Export Grid from the Toolbar.  
 

Return Manager Utilities  
Maintenance and Workstream features are located on the Return Manager Utilities tab.  
 

Recover 

You can recover previous copies of tax returns. The system automatically saves up 
to four copies of a return: the current copy, two previous copies, and the first 
saved copy. Use the Recover feature when a return cannot open because of an 
error or corruption, or because you would like a previous copy.  

 
Steps to Recover Tax Return Copies 
 

Back-Up and Restore 

In Return Manager, you can back up tax returns to a specified location. If you 
choose to back up returns to a location that already contains a backup file, the 
Backup utility appends the data into one file. After backup, you can delete 
returns. You can also recall a tax return from the backup file using the Restore 
utility.  

 
Steps to Back up and Restore Returns 
 

Print Blank Organizers 

Return Manager offers the ability to print blank Organizer forms for new clients 
with no pre-existing Tax data.  

 
Steps to Print Blank Organizer Forms 
 

https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Tax%20Returns%20Manager/TM_Recovering%20Tax%20Returns%20.htm?tocpath=Return%20Manager%7CReturn%20Manager%20Utilities%7C_____1
https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Tax%20Returns%20Manager/TM_Backing%20Up%20Returns.htm?tocpath=Return%20Manager%7CReturn%20Manager%20Utilities%7CBack%20Up%20and%20Restore%7C_____1
https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Printing/PR_Printing%20Blank%20Organizers.htm?tocpath=Return%20Manager%7CReturn%20Manager%20Utilities%7C_____10
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Working Inside Tax Returns 

Saving Tax Returns 
To retain return data, you must select Save on the Application menu, click Save on the Quick Access toolbar, or 
select Save upon exit. Autosave does not replace the system save function. Like in any other true Windows 
application, the system saves a “recovery file” every two minutes. Autosave is automatically on. 

Screen Layout 

 
 

1. Title Bar 
2. The Ribbon 
3. Worksheets 
4. Worksheet Sections 
5. Entities 
6. Navigation Pane 

 
The intuitive layout in the Navigation Pane is divided into four areas: 

• Tax Authorities 
• Categories 
• Worksheets 
• Sections 

 
Each level links more specifically to the level above it. Data is always entered at the Section level. 
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Quick Access Toolbar 
The Quick Access Toolbar displays above the Ribbon. 
To move this below the Ribbon, use the customize 
button to the right of the Toolbar. Right-clicking 
commands on the ribbon allows them to be added or 
removed from the toolbar. 
 

Ribbon 
CCH Axcess Tax uses the ribbon throughout the program. The commands you use the most appear together 
under tabs on the ribbon. The ribbon displays all commands based on the current location in Return Manager or 
in a return. You can minimize the ribbon by right-clicking a tab in the window and selecting Minimize the Ribbon 
from the menu. 
 

 
 

Search Return 
Search Return produces an interactive results list (shown below) that can be filtered using the Jurisdiction Field. 
The results below are filtering from 1000 items down to the 6 worksheets shown. 
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Government to Worksheet Link 
This tool allows you to link from a field on most federal 
and state Government forms to the underlying data 
entry field. You can use this tool by placing your cursor 
on a field in a Government form and selecting the Link 
to Worksheet button in the Navigation group on the 
Home ribbon. 
 
You can also use the right-click menu and select Link to 
Worksheet 
 
If data in the selected field comes from one source, the 
program takes you directly to the applicable worksheet. 
If data in the selected field comes from multiple 
sources (i.e., Form 1040, Line 1, Wages, Salaries, Tips, 
etc.), you get the Select Worksheet/Section window that 
shows all sources for that field. Sources that contain data appear in blue 
text.  
 
When you select the appropriate section, the link takes you to the data entry field.  
.  

Data Entry Features 

Summary Grids 

Summary Grids are like spreadsheets on the screen. You can enter data into a Summary Grid. You can access 
additional fields by scrolling to the right. Add new rows by pressing the Down Arrow key or clicking the Add 
button in the upper right corner of each summary grid. 
 
For entries that require more detail than what is available in the Summary Grid, click the Detail button to enter 
the additional information. 
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Sorting Data 

You can sort the entries on each summary grid by clicking any of the column headings. 
Summary Column Totals 

At the bottom of each Summary grid, columns containing numeric data display the total of all entries in that 
column. These totals display as running totals while you enter data, making reconciliation easier while you work. 

Detail Worksheets 

Worksheet View uses IRS source document forms exclusively, where applicable, in the Detail worksheets. You can 
find all IRS facsimile forms in the first section of a detail worksheet, if applicable. 
 

 
 
If you have a long list of items, use the Find button to locate the item you 
want to edit. A dialog box allows you to pick the item from a list or search for 
the one you want using the Find tool.  
 
You can also scroll through the available items using the navigation buttons 
on the navigation bar. The navigation bar displays a counter of the number of 
occurrences. 
 
To return to the Summary grid, click the Summary button. 
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Import/Export 

Share data between Worksheet Summary grids and Microsoft® Excel® spreadsheets using the import and export 
feature. 
Exporting 

Start an export of a Worksheet Summary grid to a Microsoft® Excel® spreadsheet by clicking the Export button 
located on the grid navigation bar. 
 

 
 
When you click the Export button, this window appears: 
 

 
 

Choose to either export a Worksheet Summary grid with all the data on it or export a blank grid you can use as a 
template for importing data into the program. 

 
A Select export file window allows the selection of a different location for each export. 
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After the green progress bar completes, select Finish and the Export opens the spreadsheet in Microsoft Excel 
automatically. The exported data fills the Microsoft Excel spreadsheet.  
 

 
 

 
 

The Return ID and the Worksheet Category and Section titles appear on the Microsoft Excel spreadsheet. 
 
Edit the spreadsheet in Microsoft Excel and import it back into the tax return. 
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Importing 

To begin the import, click the Import button on the grid navigation bar. The Worksheet Import Wizard window 
appears. 
 

 
 

The window allows you to browse for your Microsoft Excel spreadsheet to import into the tax return. Click Select 
Template and the Wizard takes you to the Select/Create mapping template screen. 

 
As a best practice, check the box Save client return before import. 
 

 

 
 

When you complete the mapping, click Next. A window appears with the option to Append or Replace the data in 
the grid. 



CCH Axcess™ Tax Preparer  

Working Inside Tax Returns Page 15 

 
 

Replacing data deletes all the data in the Summary grid and all associated detail data. Additionally, any 
data imported into prior year data cells overlay ALL data in those corresponding cells. 
 

 
 

Select Import to complete the Import. 
 
Paste Special 

As an alternative to importing data from Excel, you can paste data copied from Excel and other applications into 
the worksheet grids. You can paste data into a single field or multiple fields at one time. Data to be pasted into 
multiple fields should be tab-delimited or in tabular format. 
 
From the source file, select and copy the data that you want to paste into the grid. To paste the selected data into 
the grid fields, click the cell where you want to start the paste and click the Paste Special button on the upper 
right side of the summary grid. You can also right-click the cell where you want to begin the paste and select Paste 
Special. 



Preparer CCH Axcess™ Tax  

Page 16 Working Inside Tax Returns 

 
 
The program validates the pasted data and then displays a preview window showing the first 1,000 rows of 
pasted data. An error icon displays the next failed validation data. Hovering the pointer over the icon displays a 
description of the issue. Unless the errors are corrected, only data without errors will be pasted.  
 

 
 
To view more information about an item with the failure icon, click Details. To correct validation errors, click 
Cancel, edit the data in the source file, and then repeat this procedure. Otherwise, finalize the data paste by 
clicking Paste. 

 
You cannot undo a completed paste into a worksheet grid. To remove data after a paste is completed; you 
either must close the return without saving your changes or manually delete the information.  
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Lookup Value 

Some fields have a list of pre-defined valid entry options.  
These include: 
Yes and No options boxes 
 
 
 
 
Numbered options lists  
 
 
 
 
 
 
 
To access a list of these valid entry options for a field in a Worksheet, open the Worksheet. Position the cursor on 
the field or box where you want to access the multiple-entry options. 
 
To view the Lookup Value list of valid entries: 

• Click the down arrow to the right of the field, or  
• Double-click, or 
• Select Lookup Value in the Insert group on the Home ribbon, or 
• Press F4, or 
• Right-click and choose Lookup Value from the menu 

 
To search for an entry in a long list of possible code entries, click the Search field on top of the lookup dialog 
box. Type the entry and click the search button or the enter key. Highlight the desired entry, click OK and the 
entry appears in the box. 
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Lists 

Use the List tool to create a list of descriptions and numeric amounts that you want totaled in a field. The List 
window keeps a running total of your entries and then inserts the total in the selected field on the form when 
you click OK or press Enter. All lists print in the Accountant’s copy of the return for audit trail purposes. 
 

 
 

Steps to Create a List: 

1. Position the cursor in the box where you want the list. 
2. Select the List button in the Insert group on the Home ribbon or select from the right-click menu. 
3. Modify the caption if you want to add an additional description to identify the list in the Accountant’s 

copy of the return. The default caption is your User ID, date and time stamp, and the name of the form. 
4. Enter a description for the first item and press Tab to move to the amount field and enter an amount. 
5. When finished, click OK to insert the total in the selected field. 

 
When you move the cursor off this field, a green indicator displays in the upper left corner of the field to identify 
that there is a list. 
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Notes 

There are two types of notes available: Field Notes and Return Notes. A field-level note attaches to a specific 
field, while the Return Note applies to the overall tax return. These notes print in the Accountant’s copy of the 
return as an audit trail. 
 
Field-level notes display a blue indicator in the lower left corner of the field to identify that you attached a note. 
 

 
 

Steps to Create a Note: 

1. Position the cursor in the field where you want the note if it is a field-level note. 
2. Click the Field Note or Return Notes button in the Insert group on the Home ribbon or select from the 

right-click menu. 
3. Modify the caption to customize the description to identify the note in the Accountant’s copy of the 

return. 
4. Enter the note or paste contents from the clipboard by pressing CTRL+V or right-click and choose Paste. 
5. Click OK to save and exit the note. 

 
You can characterize a note as one of these note types: 

• Preparer 
• Reviewer 
• Notes to Next Year 
• Missing Items 

 
In addition, you can assign Notes to staff members for required resolution. The program tracks the date created 
and the cleared date. 
 
Review and Missing Item notes are deleted during the roll forward process. Notes to next year carry forward to 
next year only and Preparer notes are saved until deleted. 
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After you enter and save notes using the Tax Note window, manage the notes in a grid format so they can be 
reviewed in the Notes Pane. The grid displays relevant information about each note, such as the subject, style, 
status, creator, and date and time detail. To go directly to a note in the grid, use the link provided in the Work 
Object Link column. 
 

 
 
With the Notes Pane grid, you can sort by column header and search the grid using the Find option. 
 

 
 

The right-click menu allows quick access to the available commands for each 
note. 
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Windows and Tabs 

The Window section of the View ribbon contains three options that allow you to open a maximum of four tabs or 
floating windows for each open return. The tabs remain fixed in the main tax return window; however, the 
floating windows can be positioned to float above the main tax return window. You can place the floating 
window on a different monitor, to view multiple worksheets or government forms at the same time. 
 

 
 
Right-click a worksheet in the Navigation Pane and select Show Form in New Tab or left-click and select New Tab 
on the View ribbon. This opens the worksheet and displays the new tab below the ribbon. Right-click the tab and 
select Floating to display the worksheet in its own window. You can also left-click the tab and drag it downward 
to create the floating window. Place this window on another monitor by dragging it to the desired location. When 
the tab changes to a floating window, the tab closes. Right-click the window header to choose to close the 
window or change it to a Tabbed Document. When you select more than one New Horizontal Tab Group or New 
Vertical Tab Group from the tab options, multiple worksheets will display in the program window.  
 

 
 

After creating a tab group, you can choose to move the tab to another group from the right-click menu. 
 

The Expand and Link to Worksheets options are available on the Home ribbon when viewing a 
government form. Both features open in a new window and count towards the maximum of four windows 
or tabs that you can have open for each return. 
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Estimates 

Use the Estimate tool when you want to enter a projected number in a field. A separate report identifying all the 
estimates in the return prints in the Accountant’s copy of the return. 
 
To enter an estimate, place the cursor in the amount field that you want to mark as an estimate. Click the 
Estimate button on the Home ribbon or select from the field’s right-click menu. Edit the caption and click OK to 
enter the estimated amount in the field.  
 

  
 

When you move the cursor off this field, the estimated amount appears in an orange color identifying it as an 
estimate. When estimated numbers are present in the return the Estimate Summary button on the Review ribbon 
becomes active.  
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Navigation History 

The program maintains a history of worksheets and Government forms that you accessed during a Tax 
Preparation session. Every time you open and close a Worksheet or Government form, the program adds a record 
to a session history file. The record includes the form and entity name. 
 
The history file maintains a maximum of 1,000 records. When you reach the maximum, the oldest record drops 
off as you open new worksheets or forms and add new records. Access the history by selecting the Navigation 
History button in the History area of the Home ribbon. 
 

 
 
The Back and Forward buttons in the History area of the Home ribbon allow you to navigate easily through the 
history file. 

 
The program deletes the Navigation History when you close the return. 
 

 

Deleting Data 

To remove data entry from the Worksheets, use the delete key or click the Delete button from the Edit area of the 
Home ribbon. A right-click menu is also available. Depending on the current field location and the contents of 
the return data, the delete options include: 

• Field • Entity 
• Row • Worksheet 
• Section • Tax Authority 

 
Click Yes to confirm the deletion process or click No to cancel the deletion process. 
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Calculating 

Calculate a return by clicking the Calc button in the Process group on the Home ribbon or on the Quick Access 
Toolbar. The Calc button calculates the entire return. To calculate the federal return only, select the Calc button 
drop-down and choose Federal Only on the list. 
 
After calculating both the federal and state returns, the Calc option is inactive. If you change data, the Calc 
option is available again. 
 
If you attempt to print a return that needs calculating, a warning message displays reminding you that data 
changed in the return since you calculated last. Answer No and calculate the return before printing. 
 

 
 
When the calculation completes, all open form windows automatically refresh with the results of the calculation. 
If the data changes in a field that has a tick mark, tick marks on Government forms change from a colored tick 
mark against a white background to a white tick mark against a colored background; tick marks in a worksheet 
field disappear when the return data changes. 

 
The Calc button is available any time data in the return is changed, added, deleted, or altered. 
 

 
 
Return Group 

Calculate all returns in a corporate consolidation by selecting Calc/Return Group in the Process group on the 
Home ribbon. 
  



CCH Axcess™ Tax Preparer  

Reviewing Returns Page 25 

Reviewing Returns 

Interactive Diagnostics 
The Interactive Diagnostics window displays a list of the diagnostics generated with each return calculation. You 
can view the diagnostics while working on a worksheet, and you can move between the diagnostic summary and 
the field that generated the diagnostic. At the end of each diagnostic a 5-digit number appears in parentheses, 
use this number when contacting support for assistance with a diagnostic.  

• Electronic Filing – The return does not qualify for electronic filing. Review the return closely in the areas 
identified. You must make the necessary changes before you can export the electronic file. 

o Code 4XXXX issued when e-filing Federal and state tax returns 

o Code 5XXXX issued when e-filing extensions, Form 114 (FBAR) and various state form filings 

o Code 6XXXX issued when e-filing Federal and state tax returns 

• Warning – The return contains at least one problem that may cause your return results to be incorrect. 
Review the return closely in the areas identified. Make any necessary changes before completing the 
return. 

o Code 1XXXX issued for all Federal, state and local forms  

• Caution – The return may be in error due to a data entry error, input omission or conflicting entries. 
Review the return closely in the area identified as well as any related areas to justify your entries. Make 
any applicable changes before completing the return.  

o Code 2XXXX issued for all Federal, state and local forms 

• Informational – The diagnostics contain information provided for your use. 

o Code 3XXXX issued for all Federal, state and local forms 
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Steps to Use Interactive Diagnostics: 
1. Click the Diagnostics button on the toolbar or select Diagnostics from the Review ribbon. If you are in 

Government view when you access the diagnostics, the diagnostic references government forms. If you 
are in Worksheet view, the references are to the Worksheets. 

2. Interactive diagnostics are designated with a blue pointer to the left of the diagnostic.  

3. Double-click the blue pointer and the software opens to where the correction or modification most likely 
needs to be made. 

4. Make the change in the field. 

5. Repeat the same steps to address other Interactive Diagnostics. 

6. You can sign off on both the caution and informational diagnostics. Once the Sign-off box is checked the 
diagnostics will be moved to the signed-off view and will display the user ID, date and time. A menu 
selection is available at the top of the diagnostic report that allows you to view All diagnostics, Open 
diagnostics or Signed-off diagnostics 

7. When you are finished, close the Diagnostics window. 

Interactive Input Overrides 
An Interactive Input Override report lists the overrides used in the data entry fields. Access the Interactive Input 
Override report by clicking the Input Override button in the Reports group on the Review ribbon.  
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PDF Attachments 
The IRS accepts PDF attachments in the electronic file. Double-click the PDF File Name field at General > 
Electronic Filing > PDF Attachments to open the Attach File dialog. Select the source location of the file you want 
to attach and click Continue. Browse for the file in the Attach File window and click Open. The file name is 
entered in the PDF File Name field.  
 

 
 

 
 
Code – The program uses the PDF Code to associate a PDF attachment 
with the form it supports. For federal form-specific PDF attachments, 
this entry is required. Optional attachments for states do not need to 
use a code unless one specifically exists for the attachment. 
 
PDF File Name – Double-click this field to browse for the PDF 
attachment. 
 
Attachment Name – You must enter an attachment name. If you enter a 
Code, this field fills automatically with a name specified by the IRS, and 
you cannot modify the name. Limit your entry for the IRS attachment 
name to 60 characters. 
 
All States – If you check this box, the program includes the PDF 
attachment for all states in the electronic file.  
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Viewing and Printing Attachments 

To view PDF attachments while working in the return, click the View Attachment button in the EFS area of the 
Review Tab ribbon. You are also able to view the attachments by selecting the View Attachment button at General 
> Electronic Filing > PDF Attachments. 
 

 
 

Interactive Overrides 
The Interactive Overrides tool provides a list of the Government form overrides in a return. You can view the 
overrides while working on a form, move between the override summary and the field where you entered the 
override and change the entry, if necessary. 
 
Steps to Use Interactive Override: 

1. Click the Overrides button in the Reports group on the Review ribbon.  
2. To review or edit an override, do the following select an override and click Link to Field.  
3. The override links to the applicable form field in a separate window, allowing you to correct the missing 

or incorrect information. You must activate the override before editing the entry.  
4. Make changes to the override, as necessary.  
5. Repeat steps 3 and 4 to review or edit other overrides.  
6. When finished, click Close to exit the Field Override Report. 
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To clear all Government View overrides in the return, select All Overrides in the Delete group 
on the Review ribbon. You cannot recover overrides that you remove. Clearing all overrides 
removes the overrides and the amounts change, if appropriate, following the next calculation 
when program-calculated amounts display. 
 
 

 
As a best practice, we do NOT recommend using government view overrides. 
 

 

Viewing Statements 
You can review supporting statements for a specific Government form by selecting the Statements button in the 
Overview group on the Review ribbon. When viewing the statements, you can print them, copy them to the 
Windows Clipboard, or click Close to exit the Statement view. You must open the Government form before you 
can view the statements. 
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You can also view a specific line’s statement by clicking on the Stmt or Statement link next to the number on the 
Government form. 
 

 
 

 
 

Using Tick Marks 
Use Tick Marks to track items that you reviewed on Government Forms or Worksheets. To use this tool, click View 
in the Tick Marks group on the Review ribbon and select All, Active, or None. The default description for the red 
Tick Mark is First Review; Second Review for the blue Tick Mark; and Third Review for the green Tick Mark. The 
color of the Tick Mark button on your toolbar indicates your active tick mark. 

 
Customize the descriptions for each Tick Mark color from the Dashboard at Application Links > Firm 
Settings and defaults – Tax > Options > Tick Marks. 
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When you recalculate a return, the program checks the fields containing tick marks to see if the entries changed. 
If the data changes on Government form fields with a tick mark, the tick mark colors reverse. They display in 
reverse video. Tick marks on worksheets disappear when the data in the field is changed. 

 
Tick marks only print on the Accountants copy of the return when selected. 
 

 

Interactive Reversed Tick Marks 
Tick marks display in reverse on Government forms any time you make a change to a tick-marked field. The 
interactive Reversed Tick Marks report on the Review ribbon makes it easier for you to locate these fields. This 
report works the same way as the interactive Diagnostics Overrides reports. 
 

 
 
Highlight an item on the report and select Link to Field to link to the applicable form field in a separate window, 
allowing you to review the changed data. 
  



Preparer CCH Axcess™ Tax  

Page 32 Reviewing Returns 

Expanding to Detail 
Use this procedure to expand from calculated numbers on Government forms to the underlying detail or 
Government form schedules: 
 
Steps to Expand to Detail: 

1. Open a form in Government view, for example, Form 1040. 
2. Click a calculated field, such asTax Exempt Interest, Line 2a. 
3. Double-click the field to expand. You can also click the Expand button in the Navigation group on the 

Home ribbon or right-click the field and choose Expand. 
 

 
 

4. Expanding items that do not contain an underlying form brings you to a Detail Screen. If you expand an 
item with an underlying form, you open that specific form. 

5. Click the Go Back button on the Home ribbon or right-click the form and select Go Back.  
 

You can move between multiple occurrences of the same form (i.e., Wages) by using the Next Sheet and 
Previous Sheet buttons in the Navigation group on the Home ribbon. 
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Letters and Filing Instructions 

Viewing Letters 
Click the Letters button in the Overview group on the Review ribbon to pick the desired letter from the Print 
Preview dialog box. 
 
To view a letter or filing instruction, click the item in the navigation pane on the left. You can also manage the 
printing sequence by using the up and down arrows on the lower left of the Print Preview screen. 
 
The types of letters available include: 

• Transmittal Letter • Estimate Letter 
• Cover Letter • Extension Letter 
• Standard Filing Instructions • 5500 Letter 
• Alternate Filing Instructions • K-1 Letter 
• Privacy Policy • Summary Annual Report 

 

 
 
You can also separately copy to the clipboard, print or edit Letters and Filing Instructions in Correspondence 
Manager. 
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Editing Letters in a Return 

When you open Correspondence Manager in a return, the Word Pane shows the letter you selected. On the 
Navigation Pane, the Letter Template Library changes to Letters and Filing Instructions where you can choose the 
letter you want to edit. 
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Printing Returns 
From the Application menu, you can select various return print options including: 

• Print Entire Return  • Previewing Print Items  
• Print Return Sections • Print Organizer 
• Print Selective Pages • Printer Setup 

 
Setting Your Tax Print User Options 
 

Print Entire Return 
With CCH Axcess Tax you can preview wherever you can print. Previewing from this screen provides you the 
ability to present the statements behind the forms. Many users select the feature, “Print Statements behind 
forms” to see the detailed white paper statements in the preview navigation directly after the forms.  
 

 
  

https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Resources/Snippets/Common/UserOptions/UO_Tax_Print.htm?Highlight=user%20options
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Previewing Print Items 
You can preview print documents in the Print Preview window or 
in Adobe PDF format. Each preview method has its advantages.  
 
When you select Print Preview from the Application menu, you 
have the option of selecting the return sections you want to 
preview. For example, you can select to preview the entire return 
or only a state return. The Print Preview window displays items 
such as return sections, forms, and statements on a page-by-
page basis. A list of all the selected print items is displayed on 
the navigation panel. You can reorder items in the navigation 
panel within each copy type.  
 
When you select Print Entire Return Preview to PDF on the 
Application menu, you are requesting a preview of the entire 
return for selected copy types. This method also gives you the 
flexibility to move between Adobe and Tax to review or work on a 
tax return while your preview remains open.  
 

Printing Organizers 
Printing Organizers is accessible from a prior year Individual or Fiduciary return only and is available when the 
current year Organizer applications are released in November. Organizers can be reprinted as needed.  
 

 
Click Here for more information on printing Organizers  
 

Print Return Sections 
The navigation panel on the Print Return Sections 
window allows you to select specific sections 
relating to the open return. The following list of 
available print items will vary based on the tax 
product of the open return and the available 
sections in the open return.  
 

• Federal, State, and City Copies 
• Extensions 
• Estimates 
• Correspondence 
• Preparer Reports 
• Federal Elections Statements 
• Tax Reports 
• K-1 Packages 

  

https://download.cchaxcess.com/pfxbrowserhelp/TaxHelp/Content/Printing/PR_Printing%20Organizers.htm?tocpath=Inside%20Tax%20Returns%7CReturn%20Operations%7CPrint%20Tax%20Returns%7COrganizers%7C_____0
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Printer Setup 

Printer Setup gives you the option of assigning individual printers for the following: 

• Returns, forms, and reports  
• Correspondence items (letters, filing instructions and statements)  

The printer settings apply to all CCH Axcess Tax applications and remain in effect for this workstation until you 
change the setup. 

 

If the setup changes, the change applies to all open sessions of Tax. 

 

Steps to Setup Printer: 

1. Select Print - Printer Setup on the Tax Application menu to display the Printer Setup window.  
2. Choose the device to print returns, forms, and reports. You can select the Windows default printer or 

select a different installed printer from the printer list.  
3. To print to an installed fax, select the device from the Print to fax list.  
4. To print to a document imager, select the device from the Print to document imager list.  
5. Select Installed document imager can process landscape forms if your document imaging software is 

capable of processing landscape forms. If not selected, landscape forms printed to the document 
imager are compressed and printed in portrait format.  

6. Choose the default Windows printer or a specific printer to print correspondence, such as letters, filing 
instructions and statements.  

 

 
 

Click Properties to edit printer properties, such as tray selection to print letterhead, for the selected 
Correspondence printer. 
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Return Management Options 

Tax Return Versions 
From the Application Menu, use Save As > New Version to create a 
new version of a return. You can have up to nine versions of a return. 
 
Add a description to the version by selecting Version Description in 
the Activity group on the Manage ribbon. The Return Version feature 
is useful when you amend a return and want to preserve a copy of 
the return as originally filed. In this situation, we recommend as a 
best practice to save Version 1 as the Amended return and Version 2 
as the originally filed return. 

Return History 
Use the Return History button on the Manage ribbon to view a return's history log. This log, recorded by session, 
contains a record of return activities such as calculation, print, etc. A session begins when you open the return 
and ends when you close the return. 
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Update Status 
The return status, if set using Update Status, also records by session with the most recent status displayed at the 
bottom of the window. 
 

 

Securing Returns 
Password protection is available if you select Secure Return on the Manage ribbon. The program requires a 
password to view, modify, or print data. Any staff member with access to Tax Preparation and who knows the 
password can access the secured return. 
 

 
 

 
When printing a password-protected return to a PDF file, the same password does not protect the PDF 
file. 
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Help 

Accessing Help 
The program provides many different levels of help. You can access a list of the various help tools on the Help 
ribbon.  
 

 
 

 
 

• Help Topics provide an index to almost every 
aspect of using the program. Topics include 
data entry, configuring the toolbar, keyboard 
commands, electronic filing, K-1 
import/export, etc.

Help Topics

• Click the About button on the ribbon to 
display product version information about 
Tax.

About

• Direct access to the various Wolters Kluwers 
Tax and Accounting web sites.Web

• While on a data entry field, click the Field 
button on the ribbon for the instructions for 
that field.  (F1 Function key) 

Field

• The Government Form Instructions allows 
you to launch your web browser and link to 
the instructions for the current federal or 
state tax form.

Form

• Use the Cross-Reference help to determine 
the worksheets and sections the program uses 
in the computation of a specific line on a 
Govt. form. On-screen cross-references are 
available for various states. (F1 Function key) 

Cross-Reference

• From any worksheet, click the Worksheet 
button for general instructions for the 
worksheets. (F2 Function key) 

Worksheet 
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Appendix – Integration 

CCH Axcess™ Workstream 

Batch Linking Projects and Returns 

You can use the Batch Link utility to link returns to projects in large numbers. This eliminates the need to open 
each return and manually link it to a project. It also helps prevent the possibility of missing a project/return 
link. 

 
 
You must have the firm-level batch link and tax return security rights to use this utility. 
 
Run the Batch Link utility after hours when no one is working in CCH Axcess. If another user edits a 
project or return while the utility is running, the changes may be lost. The Batch Link utility may take an 
extended amount of time. 
 
Select Batch Link CCH Axcess Tax Returns from Application Links > Firm > Utilities > Workstream to select 
filters to locate projects for linking and then click Find Returns. Use the filters in the window to link 
projects to returns by Return type. 

 
When the summary window displays you can: 

• Review matched returns - to view returns automatically matched to projects. 
• Refine project filters - if not all filters were applied and there are unmatched returns. 
• Manually select projects - if there are unmatched returns. 
 

Click Continue to display the confirmation window, where you can print a report of returns not linked to projects. 
This report will indicate why any tax returns were not eligible to be linked, such as the client not having any 
open projects or that the return is already linked. 
 
Click Link to complete the process and update each return with the matched project. 

Linking Projects and Returns in Return Manager 

To link a tax return to a project in Return Manager, click Link to Project on the Utilities ribbon. Link to Project is 
also available inside the tax return on the Manage ribbon. A Link work object window appears. 
On the Link work object window, link to a new project on the New Project tab, or select an existing project on the 
Existing Projects tab. Only existing projects for the same client are available to select. 
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Configure Workstream Interface 

Edit the Return Configuration Set on the Configuration page of the Dashboard to set a default type and template 
for project creation from Axcess Tax. You can also check the box to Establish link to project when creating a 
return and to Prompt users to update project status when a return is closed. The window to update the project 
status when closing the return allows the user to update the return status as well. 
 

 
 
After linking to a project, access linked tax returns from My Assignments, Project Assignments, Notifications, the 
route sheet, and the open project window. CCH Axcess refers to linked returns as Linked Work Objects. In 
addition to accessing the work object, you can update the status of the work object on the route sheet without 
opening the return. 
 
You can also access the Route Sheet and Update Status function from the Return Manager or within the tax 
return. If properly configured in the template or project, rolling the work object forward can trigger the project 
roll forward. 
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You can link multiple tax returns to a single project. In that case, using the Open Linked Work Object 
function on the Dashboard opens the first linked work object listed on the Route Sheet. 
 

 
You can select the client from those listed, 
search for another client, or (depending on 
your security rights) create a New Client. 
Once you select a client, click Link. The Link 
work object window opens. 
 
 
 
 
 
 
 
 
 
 
From here, users can create a new project for linking, or 
select an existing project. If creating a new project, 
choose the Create method and click Create & Link. 
 
If you are selecting an existing project, only existing 
projects for the same client are available. Choose the 
project and click Link & Open to launch the project 
window or Link & Close. 
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CCH Axcess™ Practice 
You can send time clock transactions for each tax return to Practice Time Capture. You can automatically have 
clocks start when a return is opened and have the service code auto-populate by setting up return 
configurations using the Practice Clock Interface. 

Set Practice Clock Interface and Transaction Defaults 

In the Dashboard Application Links menu, click Configuration > Return configuration sets under Tax. Click the  
To expand a configuration set. Select Practice Interface from the navigation pane. On the clocks tab, check the 
box to enable the time clock for Practice.  

 
This will override any decisions made in User Options regarding automatically starting a clock when 
opening a return. 
 

For each return type, select the 
default service code for that return 
from the drop-down menu. You can 
use the default description 
automatically provided in the 
Description field or you can create 
your own. The description field will 
flow to the internal notes field for 
clocks and time transactions. Click 
save & close when done. 
 
 
 
 
 
 
 
 

Set Practice Invoice Interface and Options 

You can send tax return invoice details as a 
progress bill to Practice Billing and Invoicing. Click 
on the Invoice Amount tab. Select the box to 
Enable sending invoice amounts to Practice.  

You can use the default descriptions provided or 
create your own. Using the default would generate 
the current year's tax return as the description. 
Once finished, click Save & Close. 
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CCH Axcess™ Document 
On CCH Axcess Dashboard > User Options 
> Tax > Interface Options > 
Document/Engagement option, users can 
select to Send tax return files to 
Document. 
 
 
Select Always send to always send the PDF 
copies of tax return to Document 
automatically. Select Prompt me to be 
prompted before sending the PDF copies 
of a tax return to Document during the 
print process. 
 
 
 
 
 
 
 
 
 
The Add Files window will appear when Always send is active or if you select Yes after being prompted. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
See this KB article for steps to configure Tax Mapping in the CCH Axcess Document.  
  

https://support.cch.com/kb/solution/000114801/000114801
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CCH Axcess™ Financial Prep  
Click Financial Prep on the Import/Export tab of a linked return.  

 
Instructions on linking an Engagement to a CCH Axcess return can be found in this KB article.  
 

 
 
 
 
 
 
 
 

CCH ProSystem fx Fixed Assets 
Click Fixed Assets on the Import/Export tab of any return. The default file path is C:\FixedAst\UserData. Use the 
Browse button if the Fixed Assets data is located on a network drive. Select the fixed asset file then click Next to 
choose the import of totals only or all asset details. 
 

CCH ProSystem fx Planning 
Export to ProSystem fx Planning is available for 1040 returns. Click Planning on the Import/Export tab of the 
Axcess ribbon. 
 
Click Launch Planning after 
the export is successfully 
completed to view the 
exported data.  
  

https://www.youtube.com/watch?v=8zCi0mu6UnI
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CCH® ProSystem fx® Engagement  
CCH Axcess Tax users can save their ProSystem fx Engagement username and password under Dashboard > User 
Options > Interface Options. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click G/L Bridge on the Import/Export ribbon to begin the process of importing the trial balance into a CCH 
Axcess Tax return. On the G/L Bridge window, two options are available. Quiklink will be available when using the 
option Select client for import. 
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